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EsoReflex Project

ES+
+

Make pipeline recipes accessible to general users

B Recommended environment to run ESO VLT pipeline “recipes”
B Gives users enough information how to run recipes

B Reflex is based on the Kepler Workflow engine
(https://kepler-project.org), which provides a graphical user
Interface (Java)

B |n case of problems please contact usd-help@eso.org (include
iInformation about workflow, data, operating system, see also last
slide)
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Design Goals

B Document dependencies

B Organize data

B Run pipeline with single click
B Monitor progress

® Do bookkeeping

B Allow pre-defined interaction*

B Allow insertion of user procedures in several command line
languages

*currently interactive python windows (python needed for installation)
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Workflow driven Data Reduction
A&A 559, A96 (2013)
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ABSTRACT
Context. Data from complex modern astronomical instruments often consi different science and calibration
files, and their reduction requires a variety of software tools. The executi¢
needs to be tuned and super+ often by individual researchers that are
Aims. The efficiene ion can he improved by using automat

[ customized components [or the Kepler work{low
chart-like representation of the data reduction process. Ko
Sc results. thorough book-keeping, data progeny tracking. inter:

products. We found that such workflows enable the reduction of complex data by non-expert users and minimizes i

book-keeping errors.
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Basic Reflex Workflow

file:/scratch/smoehler/reflex_devel/s. . lexjworkflows,fors-5.3.5/fors_pmos.xml

[slalx]

File Edit View wWorkflow Tools

Window Help

QaF e/ lle»m

e

Search Components
‘ H Search ‘

‘Advanceds...l Sources | Cancel ‘

Components | Data | Qutling :

Workflow |

%m

FORS Workflow For PMOS Data (v. 5.3.5)

This is a basic workflow to help with data
organisation and execution of the pipeline.
The workflow was generated without a
review of the quality of the science products.|

All Ontologies and Folders

Workflow Instructions

Setup Directories ] [ Global Parameters

= actor with
interactive option

Components
Frojects
Statistics
[ Demos
[ Actors
[ Dataturhine
[ Directors
] Esoreflex
[ Job
] Opendap
) Outreach
LR

L B O

0 results found.

Ta run this workflow on the demo data: & ROOT_DATA_DIR: fscratchjsmoehler/refiex develidata/

ipeFailurem K

- Turn on highlighting. Choose “Teols"-> “Animate at Runtime" Input: @ RecipeFailureMode: As|
from top menu and set it to 1",
- Press the "Run" button OR entrl-R to start the workflow.

® RAW_DATA_DIR: $ROCT_DATA_DiRrefles input/fars/

u do NOT want to use the
ne:

Ta run on a different data set: Only change CALIB_DATA_DIR i
red with t

- Click on RAW_DATA_DIR and set as appropriate. calibration data deli
All subdirectories of RAW_DATA_DIR will be searched for data.

- If desired, change END_PRODUCTS_DIR.

- Press the "Run" button OR cntrl-R to start the workflow.

o EraseDirs: false
®CAUB_DATA_DIR: (scratchismoehlenrefies devel/software/calibfors5.3.5/

None of the dir ies below should be a subdirectory of

RAW DATA DIR or CAUB_DATA DIR

The general concepts of Reflex are described in ® FITS_VIEWER: fu

Astron. Astrophys., 559, A96. Please credit this paper in
publications on research that used Reflex.

Workflow tutorial and Fors pipeline manual can be found here:
http://www.eso.org/sci/software/pipelines/#reflex_workflows

Qutput:

& END_PRODUCTS_DIR: $ROOT DATA_DIR/refiex end_products @ GlobalPlotinteractivity: true
Working Directories:

© BODKKEEFING_DIR: $ROOT_DATA DIRjrefiex_book_keepingffars-pmos

®10GS_DIR: $ROOT DATA_DIRjreflex loas/fors-pmos

= TMP_PRODUCTS_DIR: SRODT DATA_DIRireflex tmp_products/fors-pmos.

@ BOOKKEEPING DB: $BOOKKEEPING_DIR/bookkeeping.db

& SelectDatasetMethod: interactive

& ProductExplorertode: Triggered

Global parameter for the behaviour when a recipe fails.
‘Ask' means that each time a re ils, the choice b
continue or stop wil be presented. ‘Continue® means that
the workflow will ignore errc antinue. " Stop’ means
the workflow will stop.

Change "EraseDirs" to true’ to erase
BOOKKEEPING_DIR, TMP_PRODUCTS_DIR and LOGS_DIR
each time the workflow is run (Lazy Mode will not work anymore)

Program to use for the inspection of input/output products.
Use full path name if itis not in the standard path

warkflow.

Set to "false" to disable interactive GUIs for the

Each interactive actor can specify its own setting,
which overwrites the choice given here,
Specify how datasets for processing are selected

{ New* = never tried before, "Reduced” = successfully
run before, "Failed"=unsuccessfully run before), or set to
“Interactive” for interactive selection

Specify when you want to see the ProductExplorer GU|.
"Triggered” = show it aft:
"Enabled” = show it after each dataset
“Disabled” = never show it

Step 1:
Data Organisation
and Selection

Step 3:
Science Reduction

Step 2:
Creation of Master Calibration Files

Step 4:
Qutput
Organisation

MasterBias

ForsPmosScience

ot et

Productienamer

Datzzset Selection

E

igise Curent Dataset

8 Set

ProductExplorer

Il data sets have been reduced,

[+]

| ]
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Reflex Data Organisation

DataOrganizer

dataEsets aul
B’ Dataset

-

science file associated calibration files

&=l »/[7 w/l/ m/Vm/V Yoy

LA

; processed_dark , processed_dark

processed_
1 flat ’
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Reflex OCA Rules

DataOrganizer

datasete ot classifying, organizing and associating astronomical data
based on their meta-data (FITS keywords).

B Processing steps imply Data Organization
B Data organization defined in “OCA rules”: text file
B Three types of rules:
B Classification (, This is a Raw Dark®)
B Organization (,These Raw Darks are processed together”)
B Association (“select Biases based on properties of Raw Darks")

EsoReflex , NEON School Garching, May 2016 =1IE ==+ 11]]1 == =R



|j FORS2.2008-07-20T00:14:58.01 4.fits
[y FORS2 GRS S800RI 19 GG435 81 .fits
[ fors2_extinct_table. fits

[y FORS_GDT &00RI_GG435 Cl.fits

SCIEMCE_LSS

GRISM_TAEBELE
EXTINCT_TABLE

GLOBAL DISTORTION_TAEBLE

¢ CBIAS
[ FORS2.2008-07-20T11:19:36.554. fits BlAS
[y FORS2.2008-07-20T11:20:10.437.fits BlAS
[y FORS2.2008-07-20T11:20: 44, 430.fits BlAS
[y FORS2.2008-07-20T11:21:18. 443 fits BlAS
[y FORS2.2008-07-20T11:21:52.466.fits BlAS

¢ CJcAaL LSS
[y FORS2.2008-07-20T11:11:24.872.fits SCREEM_FLAT LSS
[y FORS2.2008-07-20T11:12:17.616.fits SCREEM_FLAT LSS
[y FORS2.2008-07-20T11:13:10.651.fits SCREEM_FLAT LSS
[y FORS2.2008-07-20T11:14:02.655.fits SCREEM_FLAT LSS
[y FORS2.2008-07-20T11:14:55. 700.fits SCREEM_FLAT LSS
[y FORS2.2008-07-20T11:16:47.320.fits LaMP_LSS
[y FORS2_ACAT 600RI_ 19 GG435_S1.fits MASTER_LINECAT

[y FORS2_GRS_B00RI_16_GG435_81.fits

o ] BlAaS
¢ [ STD_MOS

[y FORS2.2008-07-20T01:13: 46, 301 . fits
[y FORS2_GRS_600RI_19_GG435_51.fits

[ forsz_eg274.tfits
[ forsz_extinct_table.fits
[ forsz_telluric_regions.fits
o [ BlAS
¢ [CJcCAL STDS
|j| FORS2,20053-07-20T11
|j| FORS2,20053-07-20T11
|j| FORS2,20053-07-20T11
|j| FORS2,20053-07-20T11
|j| FORS2,20053-07-20T11
|j| FORS2,20053-07-20T11

[y FORS2_ACAT G600RI 19 GG435_51.fits

(32136, 8681 fits
(323,605 fits
(310,580, fits
(357,633 fits
135044, 507 fits
(37376538 . fits

[y FORS2 GRS _G600RI_18_GG435_51.fits

o ] BIAS
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GRISM_TAEBELE

STAMDARD MOS
GRISM_TAELE
STD_FLUX_TAEBLE

EXTINCT TAELE
TELLURIC_COMTAMIMATION

untick to

HHHH?HHHHHHHHHHHHHHHHHHHHHHHHHHHHHHH

SCF{EEN_FLAT_MDS> deselect file
SCREEM_FLAT MOS

SCREEM_FLAT MOS
SCREEM_FLAT MOS
SCREEM_FLAT MOS
LAaMP_MOS
MASTER_LINECAT
GRISM_TAELE
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Reflex OCA Rules

DataOrganizer
ﬂdalams out classifying, organizing and associating astronomical data
based on their meta-data (FITS keywords).

B Processing steps imply Data Organization

B Data organisation defined in “OCA rules”: text file
B Three types of rules:
= Classification ( ,, This is a Raw Dark")
= Organization (,These Raw Darks are processed together”)
= Association (“select Biases based on properties of Raw Darks®)

B DO produces DataSets: set of science files to be processed
together, plus all additional files needed for processing

B Each file in DataSet has a category (e.g. “raw bias”) and a purpose
actionl/action2/... (e.g. ,MasterBias/MasterDark")
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DataOrganizer

-

science file associated calibratis

Vr:::;e““fffm/f? mt/l7m ,

p []r{!-‘..t.\'vl.‘ﬁd dark , prm.uwd dark
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RawFiles:|j
FORS2.2008-0/7-20T00:14:58.014.Ffits SCIENCE_LSS L[SCI_LSS1
FORS2_GRS_GOORI_19_GG435_81.fits GRISM_TABLE L[LSCI_LSS]
fors2_extinct_table.fits EXTINCT_TABLE [SCI_LSS]
FORS_GDT_BOORI_GG435_C1.fits GLOBAL_DISTORTION_TABLE L[CSCI_LSS]
fiction: BIAS
RawFiles:
FORS2.2008-07-20T11:19:36.554 . fits BIAS [BIAS/SCI_LSS]
FORS2.2008-07-20T11:20:10.437 .fits BIAS [BIAS/SCI_LSS]
FORS2.2008-07-20T11:20:44.430.fits BIAS [BIAS/SCI_LSS]
FORS2.2008-0/7-20T7T11:21:18.443.Tits BIAS L[BIAS/SCI_LSS]
FORS2.2008-07-20T11:21:52.466.fits BIAS [BIAS/SCI_LSS]
fiction: CAL_LSS
RawFiles:
FORS2.2008-07-20T11:11:24.872.Ffits SCREEN_FLAT_LSS LCCAL_LSS/SCI_LSS]
FORS2.2008-0/7-20T7T11:12:17.616.Fits SCREEN_FLAT_LSS LCAL_LSS/SCI_LSS]
FORS2.2008-07-20T11:13:10.651.fits SCREEN_FLAT_LSS LCCAL_LSS/SCI_LSS]
FORS2.2008-07-20T11:14:02.655.fits SCREEN_FLAT_LSS LCCAL_LSS/SCI_LSS]
FORS2.2008-07-20T11:14:55.700.Ffits SCREEN_FLAT_LSS LCCAL_LSS/SCTI_LSS]
FORS2.2008-07-20T11:16:47.320.Ffits LAMP_LSS [CAL_LSS/SCI_LSS]
FORS2_ACAT_GOORI_19_GG435%_81.fits MASTER_LINECAT LCAL_LSS/SCI_LSS]
FORS2_GRS_GO0ORI_19_GG435_81.fits GRISM_TABLE LCCAL_LSS/SCI_LSS]
fiction: BIAS
RawFiles:
FORS2 .2008-0/7-20T11:19:36.554 . fits BIAS L[BIAS/CAL_LSS/SCI_LSS]
FORS2.2008-0/7-20T11:20:10.437.fits BIAS L[BIAS/CAL_LSS/SCI_LSS1
FORS2.2008-07-20T11:20:44.430.fits BIAS [BIAS/CAL_LSS/SCI_LSS]
FORS2.2008-07-20T11:21:18.443.fits BIAS [BIAS/CAL_LSS/SCTI_LSS]
FORS2 .2008-07-20T11:21:52.466.fits BIAS [BIAS/CAL_LSS/SCI_LSS]
fiction: STD_MOS
RawFiles:
FORS2.2008-07-20T01:13:46.301.fits STANDARD_MOS C[STD_MOS/SCI_LSS]
FORS?2_GRS_GOORT_19_GG435_81.fits GRISM_TABLE [CSTD_MOS/SCI_LSS]
fors2_epg274.tfits STD_FLUX_TABLE [STD_MOS/SCI_LSS]
fors?2_extinct_table.fits EXTINCT_TABLE LSTD_MOS/SCI_LSS]
fors2_telluric_regions.fits TELLURIC_CONTAMIMATION LC[STD_MOS/SCI_LSS]
fiction: BIAS

RawFiles:
Ce . ENDCD ONR_NT_OATAN-14-5L2 H14 &b T 11 fTawt
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Select Datasets
Selected Data Set #Files | | Reduced | | OBS. TARG.MAME IN
Data Set Ch v] FORSZ2,2008-07-20T00:14:58.014 25|- Rho0phZc0g-29 GF
ata oe ooser 2 FORSZ.2010-03-17709:17:19.236 15| RCS2-1514 15.284181 10.05738|GR
) [v] FORSZ.2010-03-22T06:55:17.701 30/- BU1E GR|
datasets_in dataset_out [v] FORSZ.2010-05-03T02:36:35.486 30/- WCC1684 GF
v] FORSZ2.2012-06-22T04:00:32.921 29]- W707-Sco GF
p «] ] | L
| Save all || Inspect highlighted || Select complete || Deselect all | Filter:
| Continue || Stop |
Selected Data Set #Files Reduced OBJECT SE
v] SHOOT.2009-11-15T02:27:32.567_tpl 119 g-oclock-#2 UWE
v] SHOOT,2006-11-15T02:27:37.699 _tpl 93|- g-oclock-#2 IS
v] SHOOT,2000-11-15T02:27:41.138 tpl 73l s-oclock-n2 MR
v] ¥SHO0.2010-09-28T09:22:39.267 136]- 2MA5505405465-1112000|UVE
v] HSHOD,2010-09-28T06: 22: 49,527 78- 2MASS]05405465-1112000|NIR
v] HSHOD,2010-09-28T06: 23:00.069 105]- 2MASS]05405465-1112000[W15
v] ¥SHOD.2010-09-28T09:23:55.713_tpl 136]- 2MAS5]05405465-1112000|UVE
v] ¥SHOD.2010-09-28T09: 24:06.367 _tpl 79| 2MASS-05405465-1112000|NIR:
v] ¥SHO0.2010-09-28T09:24:17.455 tpl 105]- 2MAS505405465-1112000[WIS
v] ¥SHO0.2011-04-24T23:27:20.871 75|- STD,TELLURIC S
: w = Incomplete Dataset
v] ¥SHO0.2014-03-16T08:27:56.758 56|- CINGCBE121 LEE4613 WIS . - nCO p e e a ase
Missing SKY_SLIT_NIR ( I I d d f
4] I [ [»
| Save all || Inspect highlighted || Select complete || Deselect all Filter:
| Continue || Stop |
L= =
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Reflex FitsRouter

file:/scratch/smoehler/reflex_devel/s. . lex/workflows/fors-5.3.5/fors_pmos.xml [=a =3 x4

File Edit View Workflow Tools Window Help

SUCVESIEY I L AL JelealiaiR 3

[ Components | Data | Outline 1 [ warkflow |
: DDEDirectar B
Search Components é This is a basic workflow to help with data
- organisation and execution of the pipeline.
\ | search || FORS Workflow For PMOS Data (v. 5.3.5) e e s i
E review of the quality of the science products.,
‘Advanced 5. | Sources | Cancel |
: Workflow Instructions i i Global Parameters - actor with
All Ontologies and Folders |v : Setup Directorias interactive option
o |3 Compenents )
o Projects To run this workflow on the demo data: & ROOT_DATA_BIR: /scratch/smoehlerireflex_devel/datal
o &) Statistics : - Turn on highlighting. Choose "Tools"-> “Animate at Runtime" Input: @flecperaturemoas: sk 1’:’:1‘123?5’1:&:‘3—:Trk\::‘-::?lI;:\::E‘ 4 r:‘»“n’f,cri\ T
o [ | Demos : from top menu and set it to “1". | LAk eact - arecpefals, e choceto
o = : - Press the "Run" button OR entrl-R to start the workflow. & RAM_DATA_DIR: SROOT_DATA_DiRfreflex_input/fors/ continue or stop wil be presented. 'Continue’ means that
| Actors E the workflow will ignore errors and continue, “Stop' means
o [ | Dataturbine i To run on a different data set: Only change CALIB_DATA_DIR if you do NOT want to use the the warkflow will stop
o [_| Directors é - Click on RAW_DATA_DIR and sat as approprista. calibration data delivered with the pipeine @ EraseDirs: false Change "EraseDirs" to true’ to erase
: All subdirectaries of RAW_DATA_DIR will be searched for data. BOOKKEEPING, DIR, TMP PRODUCTS_DIR and LOGS_DIR
o= [ | Esoreflex E - If desired, change END_PRODUCTS_DIR. & CALIB_DATA_DIR: /scratchismoehler/reflex_devel/software/calibifors-5.3.5/ each time the Warkfiow 1S run (Lazy Made wil not work anymore)
o [ Job : - Press the "Run" button OR cntri-R to start the workflow. Mone of the directories below should be a subdirectary of ) ‘ .
o [_| Opendap The general concepts of Reflex are described in RAW_DATA DIR or CAUB_DATA DIR @ FITS_VIEWER: fw Pr_ug am to .uspfn t \pirn,t'n»t ton nrl inp utioutput products
e[| Outreach E Astron. Astrophys., 559, A96. Please credit this paper in Use full path name ifitis nat in the standard path.
- [ZR : f;;’;‘";;’r‘h;f:::'::r;"::p'::: R can be found here: Output: Set to "alse" to disable interactve GUIS for the whole workfiow
t - sROOT & GlobalPlotinteractivity: true h inte: e actor can specify ks own sett H
http://www.eso.org/sci/software/pipelines/#reflex_workflows = END_PRODUCTS_DIR: $ROOT_DATA,_DiRjreflex_end_products ¥ 'I.:va';ic]f'”ol\:;]\i&:::(‘-r}:Ic:i]cse?iig‘lr-e‘:;] setting,
Working Directories: -
Specify haw datasets for processing are selected
= BOOKKEEPING_DIR; $ROOT_DATA_DIRjrefiex_book_keepingffors-pmos © SelectDatasetMethod: Interactive | All" HEw® = never tied before, "Reduced” = successfully
run before, *Failed"=unsuccessfully un befare), or set to
®LOGS_DIR: $ROOT DATA DIRfrefiex logsffors-pmas Interactive” for interactive selection
= TMP_PRODUCTS_DIR: $ROOT_DATA_DIR/reflex tmp_products/fors-pmos. F g
Specify when you want to see the ProductExplorer GUI.
& BOOKKEEPING_DB: $BOCKKEEPING_DiRfbookkeeping.db @ ProductExplorerMode: Triggered :Trqnenec'= show it after all data sets have been reduced.
- - Enabled” = show it after each dataset
"Disabled"” = never show it
: Step 4:
ot OStep 1: " Step 2: Step 3: Output
ata Urganisation Creation of Master Calibration Files Science Reduction put
and Selection Organisation
Organiser
ForsPmosScience ProductRenamer
e oo
Set Selection
0 results found.
raset  ProductExlorer
o
iLad Il 3




FitsRouter
sorting by category
B routing by category is explicit:

specify what recipe needs
B each recipe needs well defined

1. o Input (e.g. category raw biases)
—Lﬂh——’ =5, CAuB AUX and creates well defined output

(e.g. master bias)
M relations determine work”flow”

bias_config:
sci_config:
calib_config:
CALIB_AUX config:
SCl1_AUX config:

"BlAS"

"SCIENCE_PMOS, STANDARD _PMOS"

"SCREEM_FLAT PMOS, LAMP_PMOS"

"MASTER_LINECAT, GRISM_TAELE,MASTER_DISTORTION_TABLE"

"MASTER_LINECAT, GRISM TAELE,RETARDER WAVEPLATE CHROMATISM, STD PMOS TABLE"
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Pipeline Recipes

le:/scratch/smoehlerjreflex_devel/s. . .lexjworkflows/fors-5.3.5/fors_pmos.xml ¥ & =
File Edit View Workflow Tools Window Help
: [2
QR QD @) e
Components | Data | Outline ; Workflow |
E DDE Directar =
Search Components =

: This is a basic workflow to help with data
| | search || FORS Workflow For PMOS Data (v. 5.3.5) e e A o e P
review of the quality of the science products.
|ndvanted S, ‘ :

| Sources | Cancel

All Ontologies and Folders

Workflow Instructions Setup Directories Global Parameters - = actor with

interactive option
o Components
o (4 Projects E To run this workflow on the demo data: = ROOT DATA DIR: jscratchjsmoehlerreflex develidata)
o |5 Statistics - Turn on highlighting. Choose “Tools"-> “Animate at Runtime" Input: @ ReclpeFallurzMode: Ask ‘;“:('”ﬁ"z';:’s”’;;'d“t’c“‘a’ :“L“Y:‘Lfg"*l_:‘,‘{"t"j;:‘s" a ’:‘L'If"flc""é o
o [ Dermos from top menu and set it to hakcach arecipe fa's, the cnoceto
- Press the "Run" button OR cntrl-R to start the workflow. ® RAW_DATA_BIR: SROCT_DATA_DiR/reflex_input/fors/ continue or stop wil be presented. ‘Continue’ means that
o[ Actors E the workflow will ignare ermors an Ttinue, “Stop' means
o || Dataturhine E To run on a different data set Only change CALIB_DATA_DIR if you do NOT want to use the the warkflow will stop
o [ Directors = Click on RAW_DATA_DIR and set as appropriate. calibration data delivered with the pipefine: o Eraselirs: false Change "EraseDirs” to 'true’ to crase
i All subdirectories of RAW_DATA_DIR will be searched for data. DOK : MP PRODUCTS 2GS D
o [ Esoreflex E y T CALIS_ DATA DIR: a5 BOOKKEEPING_DIR, TMP_PRODU DIR and LOGS_DIR
L - 5 E - ”“"’;"rf "a'{PE E“D.""OD“CI“_D'“~ h . @ CALE DATA BIR: = d each time the warkflow is run {Lazy Mode will nat work anymore}
e : - Press the "Run” button OR cntri-R to start the workflow. Mone of the directories below should be a subdirectory of
o | Opendap The general concepts of Reflex are described in RAW DATA DIR or CAUB_DATA_DIR ® FITS_VIEWER: fv Program to use for _l'l_pin%'m( tion ()'I inputjoutput products
o [ Qutreach Astron. Astrophys., 559, AS6. Please cradit this paper in Use full path name if it is not in the standard path
~ER s: k‘ff"”":‘;“ 'f’e:';" that ”T_Ed RE"E“I be found h Output: Set ko "false” to disable interactive GUIs for the whole warkfow
orkflow rial and Fors pipeline manual can be found here: ) & GlobalPlotinteractivity: true ate - ac vecify lte .
hetp:/iwww .es0.org/sci/software /pipelines/# reflex_workflows o END_PRODUCTS_DIR- SROOT DATA DIRfreflex end_products ¥y Each interactive actor can specify its own setting.

which overwrites the choice given here.
Working Directories:

Specify how datasets for processing are selected
© BODKKEEPING_DIR: SROOT_DATA_DIRirefiex_hook_keeping/fors-pmos ol wver tri "Reduced” = successfull
| | L i _keeping, P » SelectDatasetMethod: Interactive Al “New .nu../t-rtnnalje?fcla.: -{cd,l(.ed succes fJ||;
run before, "Failed"=unsuccessfully run befors), or set to
® OGS _DIR: $RO0T_DATA_DIRjreflex logsfors-omas

“Interactive” for interactive selection
= TMP_PRODUCTS_DIR: $ROOT_DATA_DIR/reflex_tmp_productsifors-pmos P ]
Specify when you want to see the ProductExplorer GUL
& ROOKKEEFING.DB: $BOOKKEEPING DiRbackke eping. db « ProductExplorerMode: Triggered  "Triggered” = show it after all data sets have been reduced
- = ' "Enabled” = show it after each dataset.
"Disabled” = never show it

Step 1: Step 2: Step 3: gtfp ‘E:
Data Organisation Creation of Master Calibration Files Science Reduction utpu
and Selection

Organisation

Organiser

ForsPmosScience ProductRenamer

P P

Set Selection

0 results found.

-

se Current Dataset

raset ProductExplorer

EsoReflex , NEON School Garching, May 2016 =1IE ==+ 11]]1 ZiEEEE ke




SofSplitter:
Sorting by Purpose

SofSplitter
1D fors bias_ 1 &i)ofAccumulator sof out
_Ebsc-f gyt sof in '

: :

i

raw bias frames

n n

master bias frames

sdnmﬁE ‘

sdnoub g

B Sorting by Purpose is implicit
B Purpose defined in OCA rules
B Assumes that each recipe has at least one unique file

category
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Basic Reflex Workflow

LAMP_FLAT

raw flats (—ﬁ—

MASTER_DARK

—

Information between actors* is passed by tokens

Reflex uses Set Of Files/Parameters (SOF/SOPs) as tokens
SOFs include files, categories (like “normal” SoFs) + purpose
Data Organizer organizes data in “DataSets”

DataSets are SOFs that include everything needed to process one
set of science observations

raw darks

*actor: A step in a workflow, i.e. a program that needs some external input to run.
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Looping over Datasets,
Output Organisation

file:/scratch/smoehler/reflex_devel/s. . .lex/workflows/fors-5.3.5/fors_pmos.xml

File Edit

ew Workflow Tools Window Help

Q@R Qb Il®=»)mm:ho e

Search Components

Components | Data | Outline :

workflow ‘

DOE

ector

This is a basic workflow to help with data ]
organisation and execution of the pipeline.
[ | search | FORS Workflow For PMOS Data (v. 5.3.5) ek e = s e e
review of the quality of the science products.
|advanced s...| sources | cancel |
Workflow Instructions i 1 Gl -: actor with
7 lobal Parameters
All Ontologies and Folders |v Setup Directories interactive option
o= Components )
o (5 Projects To run this workflow on the demo data: ©ROOT_DATA_DIR: jscratch/smoehlerfreflex develidatal
o @ Statistics - Turn on highlighting. Choose “Teols"-> “Animate at Runtime" Input: @ Reclperaluretiode: Ask g'::f::@j:‘*’,”{;':;’c"' "“'Y'\‘;"“?_;‘ﬂ".fe",‘.'\‘”‘: ! ‘*h’:"‘::'m’t W
o= [ Demos from top menu and set it to "1° . continue ors d finue' means th
- Press the "Run” button OR cntrl-R to start the workflow. @ RAW_DATA_DIR: SROCT_DATA_DiR/reflex_inputifors/ cars ; s
o= [ | Actors the workflow wil continue. *Stap' means
o || Dataturbing To run on a different data set: Only change CALIE_DATA DIR if you do NOT want to use the the workflow will stop.
o [] Directors - Click an RAW_DATA DIR and set as appropriate. calbration daca defuered with o ne: o Eraselire: fase Change "EraseDirs" to true’ to erase
o Esoreflex All subdirectories of RAW_DATA_DIR will be searched for data. ) BOOKKEEPING DIR, TMP_PRODUCTS DIR and LOGS DIR
B - ¥f desired, change END_PRODUCTS_DIR. ®CALS_ DATA_DIR: jscratch/smoehler/reflex develisoftware/calib/fors-5.3 5/ each time the workflow is run (Lazy Mode will not work anymore)
e [ Job - Press the "Run" button OR cntrl-R to start the workflow. None s below should be a subdirectory of h -
o [ Opendap The general concepts of Reflex are described in DATA_DIR o DATA_DIR ® FITS_VIEWER: fv Program to use for the inspection of input/output products.
& [ outreach Astron. Astrophys., 559, A96. Please credit this paper in Use full path nama if it is not in the standard path.
e LR sv”h""‘"a"‘";‘t‘;“. rf“:’:" that “T.Ed Re"e"l be found h Output: Set to "false" to disable interactive GUIs for the whole workflow
orkflow tutorial and Fors pipeline manual can be found here: ) « GlobalPlatinteractivity: true  Each Interactive Soio cify Its own Settin —
. i i ®END_PRODUCTS_DIR: SRO0T DATA DIRjreflex end_praducts interactive acto pecify its own setting,
http:/jwww.eso.org/sci/software/pipelines/#reflex_workflows which oversrites the choice given here
Working Directories:
Specify how datasets for processing are selected
BODKKEEPING_DIR: SROCT_DATA_DiRrefiex_book_k flors- " New \ ed ‘Reduced” = Stuly
. OISO OATA D ok g o s o Selctonasetethod: maratve (A T 1T e o educen  successily
®LOGS_DIR: $ROOT_DATA_DIRjrefiex_logs/fors-pmos Interactive® for interactive s election
©TMP_PRODUCTS_[HR: SROOT_DATA_DIR/reflex_tmp_products/fors-pmos . .
Specify when yo! 0 see the ProductExplorer GUI.
& BOOKKEERING_DE: $BOOKKEERING DIR/Bookkeeping,db # ProductExplorerMode: Triggersd :Tr-wnere: = show it after all data sets have been reduced.
- - Enabled” = show it after each dataset
"Disabled" = never show it
: Step 4:
oot (‘)Step 1 . Step 2: Step 3: OutrF))ut
ata Organisation : i : i i i
9 : Creation of Master Calibration Files Science Reducti P
and Selection Organisation
nitialise
MasterBias
Crganiser
ForsPmosscience Productienamer
s at e
DatgiSet Selection
0 results found.
.
| = e
= = faSet  ProductExplorer
o - - o .
-
- o =
A 4| 1 »
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Looping over Datasets,
Output Organisation

Search products Provenance Tree Category Keyword Yalue
o [ WD2039-202_DISP_COEFF_SCI_PMOS.fits = |SIMPLE T o
Show Al o [ WD2039-202_MAPPED AL SCI PMOS.fits BITP 16
(0 Last [Hour ¢ [ WD2039-202_MAPPED_SCI_PMOS.fits HAXIS 2 -
@ Al (| mapped_sci_pmos.fits_ . MAPPED_SCI_PMOS :jﬁ:g; fg;i |
O From 2002716 160629 |7 | FORsz.2009-08-28_00:42:26.9?0.ﬂts SCIENCE_PMOS ORIGIN Eeo
aked [} FORS2,2009-08-28700:48:11.917.fits SCIENCE_PMOS DATE S009-08-28T00:47:29.453
To 20/02/16 16:06:45 | ¢ D FORS2,2009-08-28700:53:56.964. fits SCIENCE_PMOS MID-0BS 55071.020847882
[} FORS2,2009-08-28700:58:41,900 fits SCIENCE_PMOS =|DATE-0BS 2009-08-78T00:42:26.970
Dataset #Evec | OBS.TARG.MAME DRR.T! [} FORS2_GRS_12008 97 free 00.fits GRISM_TABLE EXPTIME 299.9800
? |j FORS?.2015-02-26-[0?:56:45.429_tp| 5 WD 1620-301 STD D fors2_eps_theta_2009-01-25.fits F.ET&RDER_W}J«VEPLATE_CF EEE:’;‘(E]' fggg'zlzoa
[} 2016-02-20T16:06:34.574 0K WD 1620-391  STD & [ master_bias fits MASTER_BIAS CTYPEL PLEL
[ 2016-02-20T1 4:44:25.642 0K WD 1620-391 5T o [ curv_coeff_pmos fits CURV_COEFF_PMOS CRVALZ 320.91200
[ 2016-02-20T14:41:23.787 0K WD 1620-391 5T o [ curv_traces_pmos.fits CURV_TRACES_PMOS CRPI2 110.5
[ 2016-02-20T1 4:40: 26,800 oK WD 1620-391  STO o [J delta_image_pmos fits LELTA_IMAGE_PMOS | [cTvPE2 PIHEL
[ 2016-02-20T14:37:57.939 oK WD 1620-381  STD o (] disp_coeff_pmos fits [ISP_COEFF_PMOS BSCALE 1000000000
? |j FORS?.2009-08-28T00:42:26.9?0_tp| 5 WD2039-202 OBJECT o Ij disp_residuals_table_pmos.fits ['|SP_RES|DUALS_TJ‘3«BLE_P BZERD 32768.0
[ 2016-02-20T1 6:08: 34,400 0K WD2039-202  OBJECT o I mapped_norm_flat_pmos.fits MAPPED_HORM_FLAT_PMO{ |EXTHAME CHIF1
[ 2016-02-20T14:44:25,541 0K W02039-202  OBJECT o [J mapped_screen_flet_pmos.fits MAPPED_SCREEN_FLAT Pi | TELESCOP ESO'VLT'U?l
D 2016-02-20T14:42: 28,461 0K WD2039-202 OBJECT o Ij master_norm_flat_pmos.fits MﬂSTER_NORM_FL&T_PMO [R)JEC _3210066?4551% 1
D 2016-02-20T14:41: 23,672 0K WD2039-202 OBJECT o Ij master_screen_flat_pmos.fits MASTER_SCREEM_FLAT_PM EQUINGK 200'(1 =
[ 2016-02-20T14:40: 26,678 0K WD2039-202  OBJECT o [ reduced lamp_pmesfits FEDUCED_LAMP_PMOS RADECSYS FKS
[ 2016-02-20T14:37:57.813 0K WD2039-202  OBJECT o [ slit_location_pmos.its ELIT_LOCATION_PMOS LsT 66380.954
o ] spatial_map_pmos.fits SPATIAL_MAP_PMOS uTe 2547.000
o ] spectral_resolution_pmos fits SPECTRAL_RESOLUTION_PY |OBJECT WD2038-202
o Jwavelength_map_pnos.fits VAVELENGTH_MAP_PMOS | NSTRUME FORSZ2
—= e [ 2.000000000E+00 —
{] Il [H[4] Il | D B = -
Save commands ‘ Inspect Inspect with...

EsoReflex , NEON School Garching, May 2016
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Directories

* Double-click on entry to change

Setup Directories ]

* Avoid trailing blanks

@ ROOT_DATA_DIR: /scratch/smoehlerfreflex_develidata/

e DO scans all files in
RAW_ DATA DIR and
CALIB_DATA DIR

Input:

o RAW _DATA_DIR: $ROO0T_DATA_DWR/reflex_inputfors/

Only change CALIE_DATA DIR if you do NOT want to use th
calibration data delivered with the pipelne:

o CALB_DATA_DIR: /scratch/smoehlerireflex_develisoftware/calib/fors-5.3.5/

Mone of the directores below should be a subdirectory of
RAW DATA DIR or CALE DATA DIR Iz‘
RECISDATASIIRY |fscratch;’sm0ehlerfreflex_deuelfdataf
Qutput:
@ END PRODUCTS DIR: SROOT DATA DIRfreflex end products
L

Working Directories:
@ BOOKKEERING_DIR: $ROCT_DATA DIRfrefiex book_keepingifors-pmas

@ LOGS_DIR: SROOT_DATA_DIRjreflex_logs/fors-pmos

@ TMP_PRODUCTS_DMR: $ROOT_DATA_DIRfreflex trmp_productsfors-pmos

I e BOOKKEEPING_DBE; $BOOKKEEPING DIR/bookkesping.db I

\/
* Book keeping allows to skip already executed processing steps
(if all files and parameters are the same as before)

* “Lazy Mode”
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Tools

- file:/scratch/smo

Tools | Window Help

a a a b II [J Animate at Runtime... ’

Listen to Director

fCumpunents Data | Out Create Composite Actor

Search Components Expression Evaluator

| || Instantiate Component
Instantiate Attribute
Check System Settings
Ecogrid Authentication
All Ontologies and Folders Toggle Port Hames

|Advanl:ed Sl Sources |

structions

L Components Preferences t
o= Frojects . ow on the demo data:
- S Text Editor
Statistics hhting. Choose “Tools"-> “Animate at Runtim
o [ Dermos Module Manager... and set it to "1",
e [ Actors JVM MEITIDW Settings... button OR cntrl-R to start the workflow.
o= || Dataturhine i To run on a different data set:
o- | | Directors i3 - Click on RAW DATA _DIR and set as appropriate.
& # 3 All subdirectories of RAW_DATA_DIR will be searched for da
| Esoreflex : - If desired, change END_PRODUCTS_DIR. “ . . ”
o= [_|]Joh - Press the "Run’ button OR cntri-R to start the workflow. . A t t R t
[ e | o nimate at Runtime
H e general concepts of Reflex are described in
o= [ Qutreach : Astron. Astrophys., 559, A96. Please credit this paper in
o | R i publications on research that used Reflex. t f I I
- i Workflow tutorial and Fors pipeline manual can be found here: O O OW ro reSS
i http://www.eso.org/sci/software/pipelines/#reflex_workflows

ks : Delay for Animation a1 %
? Time {in ms) to hold highlight: [15g| |
OK Cancel
== — |
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Parameters

Global Parameters ey B Double-click on entry to

change

& RecipeFailureMode: lﬁslt Global parameter for the behaviour when a recipe fails

‘Ask' means that each time a recipe fails, the choice to

continue arstop wil be presentad, '"Continue’ means that . I m portant'
the workflow will ignore errors and continue, "Stap' means "
the workflow will stop.

& EraseDirs: false Change "EraseDirs” to true' to erase G |Oba| PIOtI nte raCtiVity

BOOKEEEPING _DIR, TMP_PRODUCTS_DIR and LOGS_DIR

each time the workflow is run (Lazy Mode will not work anymore) Reci pe Fai I u re M Od e

& FITS_VIEWER: fv Program to use for the inspecbon of inputfoutput products.
Use full path name if it is not in the standard path.

- Set to "false" to disable interactive GLUIs for the whaole warkflow.
'l'G|Dhﬂ|F’|ﬂthtE'Eftl'ﬂ1tv‘-kmE Each interactive actor can specify its own setting,
which owerwrites the choice given here

Specify how datasets for processing are selected

{"all", "MNew” = never tried before, "Reduced” = successfully
run before, *Failed"=unsuccessfully run befare), or set to
Interactive” for interactive selection

# SelectDatasetMethod: Interactive

Specify when you want to see the ProductExplorer GUI.

# ProductExplorerMode: Triggered  'Trggered” = show it after all data sefts have been reduced,
"Enabled show it after each dataset.
"Disabled" = never show it

EsoReflex , NEON School Garching, May 2016 =1IE ==+ 11]]1 = == <™



Saving a Workflow

File | Edit View Workflow Tools Window Help

HNew Workflow ]

- UL L 4l L IS =l

Recent Files ] Outline :-| wWorkflow

Elﬂﬁe ol OOF Director

Ctrl-2

Save ' Search

Save As...

Export As b OXML...

: = | GIF... :

Print... Ctrl-F e : Workflow In

Exit Ctrl-o bl |

e |g| Cornponents U oo _

o F'rc:jects To run this workf

o Statistics - Turn on highli

o= Demos from top men

- Actars - Press the "Ru

o Dataturhine To run on a differ

o~ [ Directors - Click on RAW.
All subdirecto

L Esoreflex - If desired, chz

o lob - Press the “Ru

T Dpendap The general conc

o Jutreach Astron. Astrophy

0= =] publications on re

Workflow tutorial
http:/iwww.es0.c

EsoReflex , NEON School Garching, May 2016

B XML can be exchanged with
others (ASCII file, “Save as”
should be used only locally)

B Paths to python scripts and
OCA rules are saved together
with the workflow

B To share;

= Make sure that the pipeline is
Installed in the target system

= Export as XML

= Edit the XML and change the
python scripts/OCA file paths

= Open the workflow and change
the data paths

=l JRON SRR ol BB = pruf |+ 3
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Complex Workflows

X-shooter Workflow for Physical Mode Data Reduction (v. 2.6.8)

2 M = axtor with
l W orkflow Imetrictions I [ Setup Directories ]l Global Parameters - e paian I

To nen this workfiow on the demo data

Imput: Wi Pl rebode: ko
- Turs oo highlighting. Chocas “Took = “Ariets @t Bustime
fop menu and st /o 10
% the “Bun” buttan QR cobr-R 0 start the workfiow, W DATE,_[1: SACET_[ATA_CH%ife e st nbar
oo NGT want 1o use e

AROOT_IATA_CHR: bucrabch ha ra s rres bla nra Brsats

To ren on a different data sei .-. hale
Chck om ROT DATA DHR asvd set as appropriabe. wErareties: fase
Al subdirectaries of RAW DATA DN will e searchoed for data. AL, DATA_DiR: wicaiibiahso-3.6.8
- ¥ danirad, change END_FAOOUCTS D Dutput:
IMPORTANT: END_PROGUCTS DM should not be s subdirects . P .
of the RAW DATA_DE, otherwise it will be searched for raw " SN AR TE_D S R DATA S R R S st AT VAR
st Warking Directorkes:

PFress the “Run” butbon OR cobr-R o start the sorkflow.
AROORKEE FING_DIR: §NOCT_DATR_DfUrefies bk bsep ngims osie
ol Pt i racE iy bree

Te menitar the pregress of the warkiicw in more dotait a TMP_PROCUETS DR $ADOT_DATA_DUrerks, g oo usts b g L
- Open “Window" -> “Buntime Windaw" in tap mens befors - - -
mEnrting the workdiow AUOOE DI SO DATA D s s im et P T T R
AEOORER FMD_D8: 5 BOCRKE B il DRsa kb g db

The gereral concepts of Refies are desoribed = - - “ P e
Astron. Astrophys.. 559, A%6. Plase credit this paper in * SDFFITRA e
publications on research that used Reflex. P T T
The K-shooter workflaw hotorial and deme data and the pipeline users maneal can ks fausd bere: - Prosu e e ra e b

hAEpC W e o O e C o Fhw are) pipe lves (@ refles_workdlows
U B e Triggaed

Step 1: i step 3: Step 4 Step 5:
Data Organisation _bl':*[:u 2 ) ) 2D map resampling, Response computation, Output
and Selection Creation of Master Calibration Files Spectral Power computation, Science reduction Organisation

flexure carrection

2R s

-»

Presiusst xplarar

TCRTER! ]

wLOHAL TIMESTAMI: $315-00-USTOHAS0T  w ESORalE: ~Supprass-pralios THUE  m END PRODUCTS SUBNA: Q0050518108 L300 EHO0 1011 30-20T2 55558 300 101 s SEIECTED DRTASETS: § @ OLTASET AAME: S5HOG 2001082372
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&% MUSE Workflow (v. 1.2.2)

Complex Workflows

I Warkflow Instructions

Setup Directories

Global Parameters ]

ol
T run this workficw on the demo dxta:

-+ ROOT_DATA_DW: kb Sesceatsalne
P AT, D85, 5 FalaT CATa, [nfarenaiodid

- Turn om highlighting. Cheoes “Teal™ = “Animats st Bun ks
Aroen top mans and st s oL
- Prass the “Aus~ butbsn OR esirl-A bs cbart B workfle.

Te run s @ diffasent dabts aet:
ke AW DATA DHIL Srd st b deoro g be,
" Al pubdkectarhaa of MAW DATA DR wil be searchad for data,
- i desired, change EMD PRODUCTS Dik.
PPOHT ANT: END PRODUCTS DI should mot be o :unn]lr-( u:-rr
of the RAW DATA O otharwise it will be Juirf_htd far

datat
Fress the “Hus™ Duthen OF CoiriR bo STart e workfiom .

o BOOSHEE PG _DF SAOIT_BATA_Deure i
2 LOGE_DH: RO DATA, CHR T s logs e

Thee generol concepts of Refles are sesorised in
Astron. Astropays.. 559, K35 Fioase cradw thas paper in
PhiC atoans O neseanch That wse

& CALE TUTA DR i ke £ B0 TE N <2 SLERS A A bevies L 2 Dbl

Ot s
# EMD_PRODUCTS SN8: £ ROOT DATH,_ D reta s s_pross

Working Directorkes:

Pt per e Mo

Ginbsl parameter for

Thee b haw

Wk B

2 FITS_wEENER: dnh

s dEwer o S E far

» ClabaiPlabinieraciidy: b

Disabie iviemcive Gl for the mtobe workfos
OlverTie s 0 5uD ok finmes Tave Dreceseno

B SRS EIOE AR s T

oo f

hie: Dans S8k CRaaser

+THD_PROCUCTS_C8: SADOT_DATA_ DELe et o rod uctsmans
o BOCRREE Pt D 3 BOCRMEE Fales_ G ohdoz epre B

#FracuctEapane e e Trigg ered

g rad
[ P T

0 a3 UG PemsshocTE sl

e g L S L

wrn e seeic abed nnos kg nhss
e ralizratione Dbl = bk

e ¥inie. it computes the
Fiske. kusas i

ins:
& & pEoad represer

trumenesl Line Sgeead Furstian |
e Fited Lired: Spr
o af tres LSF

hi raes 3 b

Deafoaik—

PET

Fraction of pieeis o e consstesed o 5k in dedoaied ofset-sky chsarations:

Froction -:l‘ v --\.k- ta be considered as sky in the torget field of view

LNEEE o m.sloc-' -:-\.‘:-’-\.I-EI‘S niCh s Ly
=3

Data reduction strategy parameters

1u ¥ mikatie ]

e it s & specifies the method used in subiroct the siy backgeound. Vabd entries aee: =nane | sublract-madel | moded | auin=. Defbul: oo
g none the sky beckgmund sobirackon & not peroeTed
o sabbact- _I:Id ke m o subtracted le g om dedicobed sky obserations or static cal

WTHES n‘\': TECOITETE ¥ ohacraations ore awsdab e
]

= spechied by the pammetsr Skyfr 2 oed then subiracbed
e 1o be ewalisted fom the target ek of e

= amt 1wk
V-0t vnboTTs e sweabie For
At my-chusralions soe not selehe for

the scimntfic chject
the aclenifc cbiect

Wiresdength range of the recons iy ched O
wSipf 3 018 ar i sky n angstmm idefauk: from 4000 b 1000 A
Step 1: Step 2: Stip: 3 5 SL_Ep 4; 05195]'5:
Data Organisation Creation of Master Calibration Files T . Cube Creation rganizing
and Selection On-Sky Calibrations and Combinatio outputs

~auppraceEEaeeTALE  glUerrnpsrSoathad o

* BN RODUCTS_SUsGm

i i s G e R e e e o Tt R i)
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AMBER

CRIRES

DETMON

EFOSC

FORS

GIRAFFE

SINFONI

SOF

SPHERE

UVES

VIMOS

VISIR

XSHOOTER

EsoReflex , NEON School Garching, May 2016

2016-04-01

2016-02-15

2016-02-15

2016-04-01

2016-04-01

2016-02-26

2016-04-04

2016-02-15

2016-04-15

2016-04-01

2016-04-18

2016-02-15

2016-03-03

2016-02-15

2016-03-02

2016-03-03

2016-04-01

2016-04-18

2016-03-31

Existing Reflex Workflows

(]
w
w

[
(]
w

o
L]
w

1.8.21

6.1.5

1.3.18

3.1.4

4.2.0

ol

http://www.eso.org/sci/software/pipelines/

1.13

1.3.0

1.12
1.4

2.18

22.12 (UVES)
18.6 (UVES-
FIBRE)

7.0

1.6

12.9

Cookbook

Cookbook

ADA IV 2006
paper

Demo Data

Demo Data (29 MB)

Standard Calibration Files page

Demonstration Package (2,5 GB)

Static Calibration Files (50 MB)

MUSE IFU 6 trace tables

Leagacy MUSE static calibrations

Calibration Database Example (255

MB)

Demonstration Package (1.2 GB)

Demonstration Package (2.0 GB)

Demonstration Package (1.7 GB)

Additional NIR telluric model calatog
(190 MB)

=lIE =11l =0

Tutorial: 1.1 (FORS-IMG)
Tutorial: 1.1 (FORS-PMOS)
Tutorial: 1.9 (FORS-SPEC)
Demo Data: 0.2

Tutorial: 1.6
Demo Data: 1 =

Tutorial: 9.0
Demo Data: 1 =

Tutorial: 1.6
Demo Data: 0.2

Tutorial: 6.7 (UVES)
Tutorial: 1.6 (UVES-FIBRE)
Demo Data: 4.1

Tutorial: 2.3 (VIMOS-IFU)
Tutorial: 2.0 (VIMOS-MOS)
Demo Data: 0.4

Tutorial: 1.1
Demo Data: 0.2

Tutorial: 2.8
Demo Data: 1.2

Release Additional

Operational on hold
Operational on hold
Operational on hold

End of maintenance

Operational on hold

Operational on hold
Operational on hold

End of maintenance
Active
End of maintenance
Active
Operational on hold

Operational on hold

End of maintenance

Active

Operational on hold

Operational on hold

Operational on hold

Operational on hold

(™



+

+ES+

0 Upcoming Reflex Workflows

Most new instruments pipelines will come with workflows

VIMOS (imaging)

HAWK-I

VIRCAM
SPHERE
AMBER

ESPRESSO
FLAMES-GIRAFFE

GRAVITY
MATISSE
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Advanced Topics

ES-
+

® Recipe parameters

B Re-executing a recipe
B Command line interface
B Sharing workflows

B Debugging workflows

EsoReflex , NEON School Garching, May 2016 =1IE ==+ 11]]1 == =R



Recipe parameters ()

B The interactive windows use some
default values as starting points. Right
click on actor, select “Open Actor”, and
change the INIT_* variables to change
them e INIT_SKYGLOBAL: FALSE
, @ INIT_SKYMEDIAN: FALSE
b o INIT SKYLOCAL: TRUE
@ INIT_COSMICS: FALSE
e INIT_SLT MARGIN: 3
e INIT EXT RADIUS: 12
e INIT_CONT RADIUS: 0
@ INIT_ EXT MODE: 1
@ INIT_SKYALIGN: -1
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Recipe parameters (ll)

B Right click on actor, select “Open Actor”

B Right-click on RecipeExecuter, select
“Configure Actor”

fors bias 1

,6"::::::ZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZ ZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZZ,_= " - | »
E recipe: fors_hiss
mode: Run El
Lazy Mode:
Recipe Failure Mode: %RecipeFailureMode o

Input Files Category:
Output Files Category:

File Purpose Processing: Strip last EI
Allow empty inputs: |
Pause before execution: |
Pause after execution: O
Clean Temporary Directories: []
Products Dir: $TMP_PRODUCTS_DIR Browse Configure
Logs Dir: $LOGS_DIR Browse Configure
Bookkeeping Dir: $BOOKKEEPING_DIR Browse Configure
EsoRex default args: $ESCORexArgs
Bookkeeping DB: $E0OKKEEPING_DB || Browse Configure
recipe_param_1: stack_method=minmax
recipe_param_2: minrejection=1
recipe_param_3: maxrejection=1
recipe_param_d: klow=3
recipe_param_5: khigh=3
recipe_param_6: kiter=999
| Commit | | Add | | Remove | | Defaults | | Preferences | | Help | | Cancel |
== ===}
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Re-executing a recipe

B Sometimes a recipe fails due a number of factors: bad
parameters, wrong data, software bugs, etc...

B The workflow reacts to the failure of the recipe depending on
parameter “Recipe Failure Mode”

Recipe Failure Mode: $RecipeFailureMode
Continue

Stop

Ask

B The Product Explorer allows to open the bookkeeping directory for
a given product file with right-click on the file and

open xterm

B Then you can re-execute the recipe with the same parameters and
output path

./cmdline.txt
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Re-executing a recipe

B Re-execute the recipe with same parameters and output path:
./cmdline.txt

B To change parameters edit the file
<recipe>.rc

B To use defaults just call esorex
esorex <reclipe> data.sof

EsoReflex , NEON School Garching, May 2016 =1IE ==+ 11]]1 == =R



Command line interface examples

m | st all available workflows:
esoreflex -1

® | oad kmos workflow:
esoreflex kmos

B Process all new data in my directory without interaction:
esoreflex -n xshooter -RAW_DATA_DIR=/data/xshooter_data

B Rerun all previously failed datasets with nonstandard workflow
parameter:
esoreflex -n muse -RAW_DATA_DIR=/data/muse_data \
-SelectDatasetMode=failed -recomputeWCS=true
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Additional Information

ES+
+

B Reflex page
http://www.eso.org/sci/software/reflex/

B Data Reduction FAQ
http://www.eso.org/sci/data-processing/fag.html

B ESO pipeline page
http://www.eso.org/sci/software/pipelines/
B |n case of problems please report to usd-help@eso.org and

Include: log (or description) of error/problem, data set id (or list of
raw files), pipeline version, operating system
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